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1. Introduction

1.1 Purpose of This Manual

This manual describes the general operation procedure for FFT vibration analysis using the O-Solution, OS-0522FFT

Analysis Function, and Accelerometer.

The procedures to obtain the averaging result of FFT analysis and perform recording for steady vibration

measurement are provided.

This manual does not handle the vibration measurements such as impact vibrations generated in a hammering test,

drop test, etc. and single shot vibration.

Performing the operations described in this manual brings the following results.

● Outputting Averaging Results of Three-Channel Power Spectra

Averaging power spectra helps you to
find the signal characteristics.

● Outputting Various Graphs

Generated noises and changes in
vibration can be grasped.
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1.2 Required Equipment

The following equipment is required for performing the operations described in this manual.

● Hardware: DS-5000 Series Data Station

Name Details

DS-5100 Main Unit

DS-0523/0526 3ch/6ch 40kHz Input Unit*

* Use the Input Unit required for the number of measurement channels.

● Software: O-Solution

Name Details

OS-5100 Platform

OS-0522 FFT Analysis Function

OS-0512 Hardware Connecting Function
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1.3 Notations Used in This Manual

In this manual, the UIs displayed on the screen are enclosed in square brackets (example: [New project]).

The operations are described in the following manner.

Operation Notation

Left-clicking the mouse Click or select

Example: Click [○○].

Example: Right-click [○○] and select [○○].

Right-clicking the mouse Right-click

Example: Right-click [○○].

Dragging the mouse Drag

Example: Drag the displayed cursor up/down.

Double-clicking the mouse Double-click

Example: Double-click the icon.
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1.4 Software Screen Configuration

The main window is displayed after the O-Solution is started. The main window is configured as shown below.

Item Description

A Title bar The software name and the active graph window name are displayed.

Double-clicking on the title bar maximizes the window. Double-clicking in the

maximized state restores the original size.

B Close, maximize/undo,

and minimize buttons

Click to close, maximize/undo, or minimize the window.

C Menu bar Used to execute the commands available on the O-Solution main window.

D Mode switching Clicking the button switches the mode between the measurement and analysis

modes.

: Switches to the measurement mode.

: Switches to the analysis mode.

E Toolbar The quick access commands which can be used in each mode are displayed.

F Window area The windows used for measurement and analysis are displayed. You can move

a window to a desired location by drag-and-drop.

The windows used in the window area are intended for analysis and measurement as described in the following

sections.
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1.4.1 Analysis Mode

Window name Description

a Scope Window A waveform of analyzed data is displayed.

It is displayed in the analysis mode.

b Graph Window Graphs of measurement and analysis data are displayed.

Multiple pieces of [Graph Window] can be displayed, and switching of graph

types, such as frame graph, trend graph, and 3D graph, is available.

c Data Manager The data file information handled by the O-Solution is listed. There are following

two types of [Data Manager].

・Time Series Data Manager:

The information of time series data file read into the O-Solution is listed.

・Analysis Data Manager:

The information of analysis data file read into the O-Solution is listed.
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1.4.2 Measurement Mode

Item Description

a Measurement Manager Measurement related data is displayed.

The displayed data varies depending on the measurement status.

・During monitoring:

List of data saved by the current settings

・During measurement:

List of data to be saved. When measurement ends, the data is confirmed and

displayed.

・During stop:

List of data saved as a temporary file

b Monitor Window A waveform of measured data is displayed.

It is displayed in the measurement mode.

c Progress Monitor The information such as elapsed time of recording, recordable time, remaining

recording time, average count, and progress of analysis is displayed.

d Level Monitor The input signal level is displayed.

You can check or adjust the signal level.

e Graph Window Graphs of measurement and analysis data are displayed.

Multiple pieces of [Graph Window] can be displayed, and switching of graph

types, such as frame graph, trend graph, and 3D graph, is available.

1. Introduction
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Item Description

f Data Manager The data file information handled by the O-Solution is listed. There are following

two types of [Data Manager].

・Time Series Data Manager:

The information of time series data file read into the O-Solution is listed.

・Analysis Data Manager:

The information of analysis data file read into the O-Solution is listed.

1. Introduction
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2. Equipment Connection Configuration Example
The following shows the types of Accelerometer and some cases of connection configuration. Each Accelerometer is

connected to the input channel (from CH1) of the DS-5000 series Data Station.

Note that this manual describes the case 1 where a single unit of triaxial accelerometer is used.

● Case 1: Using Ono Sokki NP-3000 Series Accelerometer (with Built-In Preamplifier) or the Like

When the Accelerometer (with built-in preamplifier) is used, power can be supplied from the DS-5000 series Data

Station to the sensor (CCLD).

Direct connection can be performed when the connector of the Accelerometer cable is a BNC connector.

For the case of miniature connector (UNF 10-32), a conversion adapter such as NP-2001 is used.

DS-5000 series Data Station

NP-3000 series
Accelerometer with
built-in preamplifierNP-2001

conversion
adapter

Personal computer

LAN cable

● Case 2: Using Ono Sokki NP-2000 Series Accelerometer (Charge Output Type) or the Like

Ono Sokki CH-6130/6140 Charge Converter or the like is used.

A conversion adapter such as NP-0021 cannot be used.

When the CH-6130/6140 Charge Converter is used, power can be supplied from the DS-5000 series Data Station to

the Charge Converter (CCLD).

DS-5000 series Data Station

NP-2000 series
Accelerometer with
built-in preamplifier

CH-6130/6410
conversion
adapter

Personal computer

LAN cable

2. Equipment Connection Configuration Example
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● Case 3: Using Ono Sokki NP-3000 Series Accelerometer (with Built-In Preamplifier) or the Like and Ono

Sokki PS-1300 Sensor Amplifier or the Like

DS-5000 series Data Station

NP-3000 series
Accelerometer with
built-in preamplifier

MX-100 series

PS-1300 3-Ch
Sensor Amplifier

Personal computer

LAN cable

● Case 4: Using Ono Sokki CH-1200A Charge Amplifier or the Like, Ono Sokki VC Series Vibration

Comparator, or Other Vibrometers

DS-5000 series Data Station

NP-2000 series
Accelerometer with
built-in preamplifier

MX-100 series

CH-1200A
Charge Amplifier

Personal computer

LAN cable

・For the case 3 and case 4, power is not supplied from the DS-5000 series Data Station to the

sensor (CCLD disabled).

2. Equipment Connection Configuration Example
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3. Preparation for Measurement

3.1 Preparing Measuring Instruments and Starting Software

Prepare the measuring instruments as described below.

1. Connect the measuring instruments.

Connect the Accelerometer, amplifier, etc. to the DS-5000 series Data Station with reference to the figure

provided in "2. Equipment Connection Configuration Example".

2. Turn on the powers of the measuring instruments.

Connect the DS-5000 series Data Station with a personal computer using the LAN cable.

Then, turn on the power of each measuring instrument. For details about the power supply, refer to the

instruction manual attached to each measuring instrument.

LAN

SYNC

IN

OUT

LAN

SYNC

19 V 3.5 A MAX
DC INPUT

10-28 V 6.0 A MAX
DC INPUT

MADE IN JAPAN
ONO SOKKI

Windows© Embedded

Personal computer

LAN cable

3. Turn on the power of the DS-5000 series Data Station.

Hold down the power switch of the DS-5100 Main Unit for one second or more. The power switch LED will turn

on, and the power of the DS-5000 series Data Station will turn on.

4. Start up the O-Solution.

Click the start button, [Onosokki O-Solution], and [O-Solution] in this order to start up the O-Solution.

You can also start up the O-Solution by double-clicking the O-Solution shortcut icon on the desktop.

When the O-Solution is started, the [Selecting Project] dialog will be displayed first.

3. Preparation for Measurement

10



3. Preparation for Measurement

3.1 Preparing Measuring Instruments and Starting Software 11



3.2 Creating New Project

● Creating New Project before Measurement

Create a new project before starting measurement.

When the O-Solution is started, the [Selecting Project] dialog will be displayed. Select [New project] (1), enter a

project name (2) and then click the [Execute] button (3).

Project name

● Creating Project while Running the O-Solution

To create a project while running the O-Solution, select [New project] (1) from the [File] menu.

When the [Creating New Project] dialog is displayed, enter a project name (2) and then click the [Execute] button (3).

Project name

3. Preparation for Measurement
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● Opening Saved Project

When a saved project exists, select [Open Project] (1) from the [File] menu.

When the [Open] dialog is displayed, select a target project file (2) and then click the [Open] button (3).

3. Preparation for Measurement
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3.3 Connecting DS-5000 with O-Solution

When the preparation is done, make the DS-5000 series Data Station recognized by the O-Solution according to the

following procedure.

1. Switch to the measurement mode.

Click the measurement mode icon ( ) (1) to switch to the measurement mode.

2. Check the connection.

A connection with the DS-5000 series Data Station is established automatically by default.

When the connection is completed, the graphs of valid channels are arranged automatically in [Graph Window].

3. Check the hardware information.

Select [Hardware Connection] (2) from the [Input Settings] menu to display the [Hardware Connection] dialog.

Clicking the [Search] button (3) in the [Hardware Connection] dialog displays the hardware list.

After checking the information, click the [Close] button to close the dialog.

● Checking Hardware Information at Startup

When connecting the hardware, the hardware list can be displayed.

Select [Environment Settings] (1) from the [Edit] menu to display the [Environment Settings] dialog.

Click [Measurement] (2) in the [Environment Settings] dialog and check [Display hardware list when hardware is

connected] (3).

3. Preparation for Measurement
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Click the [OK] button (4) to close the dialog.

The hardware list will be displayed in the [Hardware Connection] dialog from the next attempt to connect the

hardware.

3. Preparation for Measurement
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3.4 Setting Channels

Set the input channels of the measuring instruments according to the following procedure.

1. Display the [Input Condition Settings] dialog.

Select [Input Condition Settings] (1) from the [Input Settings] menu.

2. Set the channels.

Check the check boxes of CH1 to 3 to be used (2) and then check the [CCLD] check boxes (3).

Uncheck the check boxes of other channels.

Enter a comment and DOF information (4) for each channel as needed.

When the setting is completed, click the [OK] button (5).

Check the check box. Check the check box. Enter a comment.

3. Preparation for Measurement
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4. Unit Calibration
When the preparation for measurement is completed, perform unit calibration.

4.1 Setting Calibration

Set the signal type, sensitivity, and CCLD before starting measurement.

1. Display the [Calibration] dialog.

In the measurement mode, select [Calibration] from the [Input Settings] menu.

The [Calibration] dialog will be displayed.

2. Set the signal type.

Set [Signal type], [Unit], [EU type], and [EU value] in the [Calibration] dialog with reference to the calibration

chart on the test certificate for the accelerometer.

Enter the sensitivity value, which is specified as the range (output sensitivity) for charge amplifier, etc., to [EU

value].

It is specified as shown below in the calibration chart of Accelerometer. Refer to the value specified in the "

Sensitivity @160 Hz" field.

Since the EU value is input in the unit of V, "0.001093" is entered for "1.093 mv".

In this section, the settings are configured as shown below. After completing the settings, click the [OK] button.

4. Unit Calibration
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Item Setting content

Signal type Acceleration

Unit m/s^2

EU type V/EU

EU value 0.001093 (example)

CCLD Check the check box (uncheck for the cases 3 and 4)

Voltage sensitivity (Sensitivity) @160Hz
Bias voltage (Output Bias)

1.093
10.4

mV/（m/S² ）
VDC

Refer to the value specified for “Voltage sensitivity
(Sensitivity) @160 Hz “.

・With [CCLD] checked, +24 V/4 mA is supplied from the checked channel to the

Accelerometer, and the signal is input correctly.

4. Unit Calibration
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5. Measurement Settings

5.1 Setting Time Axis Preprocessing

The time axis preprocessing function is used to process an acquired time waveform before performing frequency

analysis.

For example, if an unnecessary noise component is mixed in the low frequency range, the noise can be removed by

setting the digital filter.

You can also change the acceleration value to speed or displacement using the time axis calculus function.

In this section, the high-pass filter (HPF) is set to cut the frequency component of 10 Hz or lower as an example.

1. Display the [Time Axis Preprocessing] window.

In the measurement mode, select [Time Axis Processing] (1) from the [Input Settings] menu.

The [Time Axis Preprocessing] window will be displayed.

2. Set the high-pass filter.

Select [HPF] for [Digital filter] (2) in the CH1 row and enter "10.000" to [Lower limit frequency] (3).

Likewise, set CH2 and CH3.

Select [HPF]. Enter “10.000 “.

5. Measurement Settings
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5.2 Setting Measurement

Configure the channel and FFT related settings in the [Measurement Settings] dialog to perform frequency analysis.

To display the [Measurement Settings] dialog, select [Measurement Settings] (1) from the [Measurement Control]

menu in the measurement mode.

5.2.1 Setting Channels

Click the [Channel settings] tab (2) in the [Measurement Settings] dialog and set the channel related conditions.

Firstly, check the check boxes of CH1 to CH3 (3).

Since the measurement target this time is steady signal, [Hanning] is selected for [Window function] (4), and the DC

cancel function is enabled to reduce DC component.

In this section, [DC cancel] is checked for each channel (5), and [Hanning] is selected for [Window function].

5. Measurement Settings
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Check the check box.

Check the check box.

Select [Hanning].

5.2.2 FFT Basic Settings

Click the [FFT basic settings] tab in the [Measurement Settings] dialog and set the FFT related conditions.

In this tab, items such as the number of sampling points and frequency range are set.

In this operation manual, the conditions are set as shown below.

Item Setting content

Sample conditions Internal (7)

Number of sampling points

(number of analysis lines)

2048 (8)

Frequency range Click [Frequency range (sampling frequency)] (9) and select [2.00kHz (5.

12kHz)] (10).

Click

Select [Internal].

Select [2048].

Select [20.00 kHz].

5. Measurement Settings
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・Increasing the value of [Number of sampling points (number of analysis lines)] makes the

frequency resolution higher (⊿f becomes smaller) for power spectrum, etc. However, the time

(single frame window length) required to calculate the instantaneous power spectrum

becomes longer, which causes poor followability to time variation.

For common vibration measurement, a value somewhere between 1024 and 4096 is set.

5.2.3 FFT Average/Detailed Settings

Click the [FFT average/detailed settings] tab (11) in the [Measurement Settings] dialog and set the averaging related

conditions.

In this tab, select an averaging method in [Averaging settings]. Also, select either [Count] or [Time] for [Averaging

conditions].

In this operation manual, the conditions are set as shown below.

Item Setting content

Averaging method Power spectrum summation averaging (12)

Averaging conditions Time [s] (13)

Time [s] 10 (example) (14)

Select [Power spectrum summation averaging].

Select [Time].

Enter “10 “.

・For details about other selectable averaging settings, refer to "O-Solution Instruction Manual

(Description of Functions)".

5. Measurement Settings
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6. Graph Display Settings
Set the number of graphs displayed and the data types displayed in graphs.

To display [Graph Window], select [Graph Window] from the [Window] menu in the measurement mode.

6. Graph Display Settings
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6.1 Changing Graph Layout

Display a graph in [Graph Window]. In this section, the layout of 3 (horizontal) x 2 (vertical) is selected for display.

To change the layout of [Graph Window], click the layout setting button on the toolbar in [Graph Window] and select

the layout of 3 (horizontal) x 2 (vertical).

Select the layout of 3 (horizontal) x 2 (vertical).

6. Graph Display Settings

24



6.2 Displaying Channels in Graphs

After changing the graph layout, display the data of measured channels.

To display the measurement data in the graph area, drag a channel from [Measurement Manager] and drop it to the

graph area.

The power spectra for three or six channels are displayed by default.

Drag and drop a channel to the graph area.

The channels are arranged as shown below.

CH1 CH2 CH3

CH1 CH2 CH3

6. Graph Display Settings
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6.3 Changing Data Types Displayed in Graphs

Change the data types displayed in graphs. In this section, the CH1 to CH3 graphs in the upper section and the CH1

to CH3 graphs in the lower section are changed to time axis waveform graphs and power spectrum graphs,

respectively.

Follow the procedure below to change the data types.

1. Display the setting screen for the items displayed in graphs.

Click to select multiple graphs (CH1 to CH3 in the upper section) for which the data types are changed (1) while

pressing the Ctrl key on the keyboard.

Then, click the [Item settings] button (2).

Click to select multiple graphs for which you want to
change the data types while pressing the Ctrl key.

2. Change the data types of upper graphs (CH1 to CH3) to time axis waveform.

When [Item settings] is displayed, select [Time axis waveform] (3) at [Data type].

Select [Time axis
waveform].

3. Check that power spectrum is displayed in the lower graphs (CH1 to CH3).

Power spectrum is selected as the graph data type by default.

6. Graph Display Settings
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Check that power spectrum is displayed for the lower graphs (CH1 to CH3).

When a data type other than power spectrum is set, set the graphs as shown below in the manner described

above.

Time axis waveform

Power spectrum

6. Graph Display Settings
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6.4 Setting Y Axis Display Unit and Scale

In this section, the Y axis display unit and display scale are set to [rms] and [Lin], respectively, for power spectrum

graphs.

1. Display the axis settings.

Click the [Axis settings] button (1) on the option bar in [Graph Window].

2. Change the display scale.

Unfold [Y-axis settings] (2) first in [Axis settings].

Select [rms] (3) at [Spectrum units], and [Lin] (4) at [Scale].

Select [rms].

Select [Lin].

・Either [Log] or [Lin] can be selected at [Display scale]. The following shows a relational

equation between [Log] and [Lin].

10 Log (Lin value)2 = 20 Log (Lin value)

Example: 6 (dB) for the case of Lin value = 2 (m/s2) when 0 dB reference value is 1

6. Graph Display Settings
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7. Temporary Measurement
Perform temporary measurement before main measurement to check that measurement can be performed normally.

When there is no problem with temporary measurement, save the project and perform main measurement.

7.1 Setting Voltage Range

1. Display the [Level Monitor] screen.

In the measurement mode, select [Level Monitor] (1) from the [Window] menu.

2. Clear the over-range hold.

Firstly, click the [Clear Over Hold] button (2).

Then, check the check boxes of all channels (3) and select the minimum value at [Voltage range] (4).

7. Temporary Measurement
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Click

Select the minimum value.

Check the check box.

3. Check if an over-range occurs.

Start measurement to see if an over-range occurs.

For the channel in which an over-range occurred, click the [▼] button to raise the voltage range by one step.

When using the medium mode, the button (▲▼) will be displayed by placing the cursor over the indicator.

Return to the step 3 and clear the over-range hold. Then perform measurement again to see if an over-range

occurs. Repeat this series of operations until no over-range occurs.

If you are worried about the occurrence of over-range, raise the voltage range by one step after adjustment.

Check the level.

Raise/lower the voltage range by one step using
the ▲▼ button displayed by pointing the cursor.

● Changing Display Mode of Level Monitor

The display mode of [Level Monitor] can be changed in three steps: large, medium, and small by clicking the mode

switching icons located in the bottom left section of the [Level Monitor] screen.

7. Temporary Measurement
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Large mode Mediummode Small mode

Mode Description

Large mode In the large mode, channels are displayed in blocks in a column, with a single block

containing six channels.

・Since this mode can display the largest amount of information for each channel, select

this when you perform measurement for a small number of channels or you want to know

the details of channels.

Medium mode In the medium mode, channels are displayed in blocks in two columns, with a single block

containing six channels.

・Select this when you want to know the details of channels and also check a large number

of channels at the same time.

Small mode In the small mode, channels are displayed using one block for one hardware unit.

・Select this when you want to know the channel statuses of individual measuring

instruments at the same time. This is useful in measuring multiple channels.

7. Temporary Measurement
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7.2 Performing Temporary Measurement

In temporary measurement, the target is operated to adjust the voltage range and scale.

7.2.1 Starting/Stopping Temporary Measurement

Use the start and stop buttons on the toolbar on the main screen to start/stop temporary measurement.

After starting temporary measurement, check the voltage range on the [Level Monitor] screen. If a channel generating

an A/D over exists, adjust the voltage range.

For the voltage range adjustment, refer to "7.1 Setting Voltage Range".

Start button (starts temporary measurement)

Stop button (stops temporary measurement)

7. Temporary Measurement
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7.2.2 Adjusting Graph Scale

Adjust the Y axis display scale while checking the power spectrum waveform displayed in [Graph Window].

To adjust the graph scale, click the [Axis settings] button (1) in [Graph Window] to display [Axis settings].

Unfold [Y-axis settings] in [Axis settings] and enter values to [Maximum value] and [Minimum value] (2) to adjust the Y

axis scale.

Set [Maximum value] and [Minimum value] (enter values).

7. Temporary Measurement
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7.2.3 Saving Project

After the measurement conditions are determined in monitoring, save the project.

When a project is saved, the burdensome setting work can be omitted for the subsequent measurements having

similar conditions.

・Note that even when you call a project, the voltage range needs to be adjusted before

performing main measurement. For details, refer to "7. Temporary Measurement - 7.1 Setting

Voltage Range".

● Project Saving Procedure

To save a project, select [Save Project As] (1) from the [File] menu.

Set the save folder (2) and file name (3) in the [Save As] dialog displayed and then click the [Save] button (4).

Select a folder.

Enter a file name.

7. Temporary Measurement
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8. Main Measurement
When the preparation for measurement is completed, perform main measurement.

In this section, recording for ten seconds and power spectrum summation averaging for ten seconds are performed.

8.1 Toolbar Used in Main Measurement

Main measurement is operated via the toolbar on the main screen.

The buttons used for main measurement are as follows.

Recording button (enables/disables recording)

Averaging button (enables/disables averaging)

Start button (starts measurement)

Stop button (stops measurement)

8. Main Measurement
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8.2 Setting Data Save

You can change the save methods for measured data, such as naming convention for files and automatic registration

in [Data Manager].

In this section, the naming convention for files is set to "Data" (with sequential number), and a request for

confirmation at registration in [Data Manager] is set.

1. Click to display the [Save Settings] dialog.

In the measurement mode, click [Save Settings] (1) from the [Measurement Control] menu.

2. Set the naming convention for files (2).

・Enter "Data" at [File name].

・Select [No.] at [Additional information].

・To change the beginning of serial numbers, enter a number in the [No.] field.

・You can check the actually assigned file name under the set conditions at [Output file name].

3. Request confirmation for recorded data when saving the file.

Check [Display confirmation dialog box before registering to Data Manager] (3).

When the setting is completed, click the [OK] button (4).

8. Main Measurement
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8.3 Performing Main Measurement

In main measurement, recording and analysis of power spectrum summation averaging are executed

simultaneously.

Follow the procedure below to perform recording for ten seconds and analysis of power spectrum summation

averaging for ten seconds.

1. Link recording with analysis.

Click the [▼] icon (1) on the right side of the start button and check [Link recording and analysis] (2).

Click

2. Enable recording and analysis.

Click the recording button (3). Recording and averaging are enabled, and the buttons become active.

8. Main Measurement
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Click

3. Start main measurement.

Click the start button (4) to start measurement recording. Measurement recording stops after ten seconds.

Click

8. Main Measurement
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・When you click the stop button before ten seconds pass, measurement is stopped at that

point. Even when measurement is stopped halfway, the recorded data and power spectrum

summation averaging up to the stopped point are saved.

4. When a confirmation message for saving recorded data is displayed, click the [Yes] button (5).

Click the [No] button to discard the recorded data.

・To register the recorded data in [Time Series Data Manager] automatically, uncheck [Display

confirmation dialog box before registering to Data Manager] in the [Save Settings] dialog.

Refer to "8.2 Setting Data Save".

8. Main Measurement
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8.4 Calculating Measurement Result

Perform double integration of calculus on the power spectrum averaged for ten seconds to convert the acceleration

signal to displacement.

Follow the procedure below to perform double integration.

1. Display the setting screen for the items displayed in graphs.

Select the target power spectrum graph for double integration (1) and click the [Item settings] button (2).

Click

Select the target power spectrum graph
for double integration.

2. Perform double integration.

Select [Double integral] (3) at [Frequency calculus].

The result of integration (4) will be displayed in the selected active graph.

8. Main Measurement
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Graph showing the result of
double integration

8. Main Measurement
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8.5 Registering Data in Analysis Data Manager

1. Click the analysis data save button.

When measurement ends, click the analysis data save button (1) on the toolbar on the main screen.

2. Check the registration in [Analysis Data Manager].

The analyzed data will be registered in [Analysis Data Manager] (2).

Click

8. Main Measurement
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9. Analysis Work
You can analyze recorded data in detail in the analysis mode.

9.1 Switching to Analysis Mode

Switch to the analysis mode to analyze recorded data.

1. Switch to the analysis mode.

Click the analysis mode button (1) on the toolbar on the main screen to switch to the analysis mode.

2. Display the recorded data on [Scope WIndow].

Drag and drop the recorded data from [Time Series Data Manager] to [Scope Window] (2).

Click

Drag and drop time series data.

3. Check the waveform displayed at [Scope Window].

The waveform of the recorded data (3) is displayed on [Scope Window].

Drag and drop all the analysis target data to [Scope Window] in the same manner.

The recorded data is displayed in [Scope Window].

9. Analysis Work
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9.2 Integration (Conversion from Acceleration to

Displacement)

Performing double integration on the recorded acceleration signal enables conversion to displacement. Follow the

procedure below to perform double integration on recorded data.

1. Display the [Time Axis Calculus] dialog.

In the analysis mode, select [Time Axis Calculus] (1) from the [Time Series Calculation] menu.

2. Execute the calculation.

Set the conditions on data manager in the [Time Axis Calculus] dialog as follows.

Check the target data for double integration (2), then select [Double integral] (3) at [Calculation type].

Check [Remove DC component before integration], then set the value for [Cutoff frequency [Hz]] and [Extreme

value].

Select [Automatic conversion] (3) at [Unit conversion].

When the setting is completed, click the [Execute] button (4).

9. Analysis Work
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Select the calculation target data.

Select [Double integral].

Check [Remove DC component before integration], then
set values for [Cutoff frequency] and [Extreme value].

Select [Automatic conversion].

Click

3. Check the calculation result.

The calculation result is added to [Time Series Data Manager] (_Calculus).

Drag and drop it to [Scope Window] (5) to check the result.

Drag and drop to check the result

9. Analysis Work
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9.3 FFT Analysis

To perform FFT analysis on recorded data, select [FFT analysis] from the [Analysis Calculation] menu in the analysis

mode.

You can configure the channel and FFT related settings in the [FFT analysis] dialog displayed.

For the setting method, refer to "5.2 Setting Measurement".

9. Analysis Work
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9.4 Comparing Power Spectra

Multiple graphs can be overlaid on one another in [Graph Window]. This allows you to compare the averaging results

of multiple power spectra easily.

・The graphs displayed in [Graph Window] in the analysis mode need to be set separately. The

operation procedure is the same as that in the measurement mode. Refer to "6Graph Display

Settings".

9.4.1 Overlaying Graphs

To overlay graphs, drag the cursor value of the channel 1 power spectrum graph (CH_001) and drop it on the channel

3 power spectrum graph (CH_003).

Drag and drop

The graphs are overlaid on each other.

Graphs are overlaid on
each other.

9. Analysis Work
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9.4.2 Checking Peak Value with Cursor

You can check a peak value with peak cursor.

To change to a peak cursor, select the target graph (1) and click the [Cursor settings] button (2) and then select [Peak

cursor] (3) at [Cursor type].

A peak cursor (〇) (4) will be displayed at a peak value.

A peak cursor is displayed at a peak value.

9. Analysis Work
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9.5 Drawing Time Trend Graph

Follow the procedure below to set the graph type of channel 2 power spectrum graph (CH_002) to time trend graph.

1. Select a graph.

Select the channel 2 power spectrum graph (CH_002) (1) and click the [Graph area settings] button (2).

2. Switch to time trend graph.

Click the[Graph area settings] button and select [Trend Graph] (3) at [Graph type switching].

3. The graph will be switched to time trend graph.

The selected graph will be switched to the time trend graph (4).

9. Analysis Work
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Makes a switch to trend graph.

9. Analysis Work
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10. Saving Project
Save the created measurement conditions, graph display method, recording data, and analysis data together in a

single project.

When you select [Save Project] from the [File] menu, the project will be saved by overwriting.

・When you want to save as a different project, select [Save Project As] from the [File] menu.

The [Save As] dialog will be displayed. Set the save folder and file name in the [Save As]

dialog and then click the [Save] button.

For details, refer to "7.2 Performing Temporary Measurement - 7.2.3 Saving Project".

10. Saving Project
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11. Measurement Note
Note the necessary information for measurement in the following form.

Title

Note

Client

Reference material

Measurement

date and time

Person who

performs measurement

Measurement location

Measurement method

Measurement conditions

Measuring instrument

mode/settings

Project name/

save destination

Data name/

save destination

Measuring

instrument/sensor

Calibration value
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